
HOW TO MAKE A GARDEN MASTER GUIDE
PART 1: CONCEPTING 

PART 1.1: RESEARCHING 

To begin making a garden one first needs to decide which garden to make. Want to make a wintery mountainous garden? A 
Tulip Garden? A Magical Pink Garden? This part is the most fun.
 
For Apple Arcade Version:  Feel free to be less concerned about endemic and specificity of plants and animals as there are 
less gardens to be thinking about.
For Free-to-Play Live Version: Be specific with choice of animals/plants/location. Be very specific with endemic-ness to make 
sure future gardens are not impacted/limited by earlier decisions. 

Rules of the Gardens (follow this as close as possible):
-30 Plants
-6 Animals (includes butterflies)
-Keep terrain flat for simplicity reasons
-Gardens are horizontal (we do not have vertical gardens or the capabilities for vertical)
-Gardens and the assets should maintain scale across all gardens. 

Other things to keep in mind: 
-Think about existing rigs, can one pick animals that might be able to use existing rigs? 
-Think about shape and diversity. Consider an idea of layout that might be appealing to what assets have been chosen.
-Plots are an essential part of the Garden design. Make sure to think about utilizing plots when making gardens.
-The more that basic items can be “re-used/re-skinned“ the better to maintain style consistency. 
-Look at past gardens and past garden documents to get a sense on how to make a garden.
-Try not to have the same plant/animal unlock more than once in the game.

PART 1.2: CONCEPT ART

Once the theme of the Garden is selected, and the names of all 30 plants and 6 animals are selected, it is time for concept 
art. 

-The software that was used previously was photoshop and procreate. In the past the plants, props and animals are all 
separated in their own files. 
-Each asset that is concepted out should either have a legend corresponding to the assets name, or written name next 
to asset in concept art. 
-Turn arounds of each animal is ideal to ensure consistent design of animals and ease of the modeler. Reduces number 
of revisions. 
-It is ok in this phase to re-visit which plants and animals were selected. As the concept artist works out the abstraction 
of the asset into the Garden Style, the artist might find it does not work. It is ok to switch things around. 
-A sketch of the garden layout should be completed in this phase. 
-Reference ﻿2d style guide ﻿and ﻿animal stylization guide﻿ for info on art direction for concept art 

PART 1.3 RESEARCH DOC

Once all of the concept art is complete and approved, a research doc should be constructed.  Use: Garden Research 
Template or equivalent to make the research doc. 

Inside the Research Document you will find the following: 
-Resources about Garden

-This is where you put in any links to documents, websites, books, resources, build links, PR links, or any other 

https://docs.google.com/presentation/d/1ygRiRZ4L553zvHapp5dhM4C3aqpbIHvJM7qFzwDGgp8/edit
https://docs.google.com/presentation/d/1_mm_4yGneekxnmXdg0rStgwCO9efWzYdnaYlkqKt2bM/edit
https://dots.quip.com/we3rAwMfwWdC


relevant information that needs to be easily accessible. 
-Garden Overview

-Fill out the following: Theme (e.g. Rainforest), Subtype (e.g. brazil, subfloor), Location (e.g. Amazon Rainforest 
Brazil), Time of Year (e.g. Spring), Time of Day (e.g. Morning), Weather (e.g. Raining), Feeling (e.g. Lush, dense, 
humid, fragrant), Number of Plants (e.g. 30), Number of Animals (e.g. 6). 
-If there is any other overview information to be added, add it under the existing slots.

-Garden Layouts:
-Place sketch and any relevant information about the layout of the Garden Space.
- Also where prop concept art is placed. 
- Eventually screenshots from unity can be placed as the Garden is complete. 

-Notes about Garden:
-Any additional information that doesn’t fit in the above categories can go here. 

-Plants in Garden:
-Place the concept art of the plants here. 
-Underneath the concept art list out the plants that are in the concept art. Add links to information about each 
plant inside the plant name. See ﻿previous Garden Research﻿ docs if this is unclear. 

-Animals In Garden:
-Place concept art of Animals here. 
-Place turn arounds here.
-Underneath the concept art list out the animals that are in the concept art. Add links to information about each 
animal inside the animal name. See ﻿previous Garden Research﻿ docs if this is unclear. 

-Additional Docs // Links
-Anything else at all that did not fit in the above categories can go here.

Upon completing the Research Doc, receive feedback from game director.

Revise document with any notes that are given.

After the Research doc is put together, add to 3D GARDENS INDEX.

PART 2: MODELING 

Once Research and Concept is finished asset creation begins. Software of choice does not matter as long as assets can be 
exported as FBX. Garden previously was using Maya LT and Blender.

﻿5 Modeling tools you need for blender﻿
﻿Learn Low Poly Modeling﻿

PART 2.1 MODELING PLANTS

Useful information on modeling plants. Plants are very important to ensure the look of Garden Tails and should be followed 
diligently. 

2.1.A Modeling Plant Rules

https://dots.quip.com/DQqjAS7zRbSB/Cottage-Garden-Research
https://dots.quip.com/DQqjAS7zRbSB/Cottage-Garden-Research
https://dots.quip.com/elTPAk7AtUsH
https://youtu.be/kejQ8nX5YZA
https://youtu.be/1jHUY3qoBu8




2.1.B Construction of Plants

2.1.B.a Modeling Leaves & Petals

With Plant construction, a large part of it is following the texture. For Plant modeling reference Part 3: 
Texturing first, ensuring the texture is complete. Follow bellow on how to create leaves and petals.

Import the texture as an image 
plane into the front or top view. 
(reference Part 3: Texturing)

Using the image texture atlas, model the petals and leaves based on the 
shape of the item. Follow the form of the illustration on the texture. Flat 
quadrated meshes. (Can use quad draw or create cube, delete all sides 
but one, then form to fit shape) Follow the illustration as close as 
possible, less transparent areas the better. Large transparent areas are 



resource intensive in engine and also cause shadow issues. 

Once the quad is complete, apply planar mapping with the corresponding axis (e.g. Y-axis) Move until the 
asset is framed in the mesh.

2.1.B.b Modeling Flowers

Flowers follow a similar construction style to leaves 
and petals. Once again, can chose between quad 
draw tool or starting with a cylinder, set it to 5 sides 
and remove everything but the top or bottom. Do not 
try and draw around the flower and get the exact 
shape. Poly count is a factor so balancing between 
poly count and transparent areas is important. 

Then Planar Map the mesh. Move UV island around 
until it fits the texture.

Depending on the flower shape, adding dimension to the flat shape can 
be a nice touch. Either inverted like shown here, or the other way. Tweak 
until it looks good. 

2.1.B.c Modeling Stems
For larger stems use a cube, sub-divide into an 8 sided shape.
For medium stems use a cube, sub divide it into 6 sided shape.
For tiny stems, just use a 4 sided shape (cube).
If there is wind in the garden sub-divide vertically (or add edge loops) to allow the mesh to bend. 3 for large, 2 for 
medium, 1 for small.
No angles over 35 degrees in stem bend. 

2.1.B.d Modeling Bushes
The Main part of the bush

Model the overall shape of the bush.  Add or take away geo as needed. The mesh will be covered with 
foliage planes, the planes will follow the base shape. Poly count can remain relatively low.

The “trunk” of the bush
Use an 8 sided “stem”, size it to a bush proportional size. If bush has unique trunk then model following the 
shape of the trunk.

The foliage

Create a “foliage unit” that can be duplicated and placed over the base 
mesh.
Use a polygonal plane. Make two diagonal cuts.
UV>Planar the polygonal plane.



Move the Island to frame the illustrated component for the bush.

Then drag the middle point down a bit to give it some dimension. Should 
be kind of like a shallow pyramid.

Move the pivot point to the “base” of the foliage plane.

Manually place each plane into place. Can also use plug-ins and snap it 
to vertices or faces. ﻿Blender Plug-In Idea﻿        ﻿Maya Plug-In Idea﻿

Make sure when placing the foliage units that they are placed evenly and 
do not clip each other too much. To speed this process up if you are 
doing this manually, place half (one side) and duplicate to the other side. 
Add any additional to get the finished look.

Bushes already exist in game, and to speed up modeling if the shape of the bush in the concept art matches a 
bush that is already made, or is similar to, re-using assets is optimal. It speeds up asset creation time.

The bush at this stage should look like the bush
on the right. The normals of this bush are not 
ideal for the look of garden. In order to get 
normals that are more suited for the look of 
garden, reference 2.1.B  Leaf Clumps and 
Normals for Bushy plants, Bushes, hedges, 
Trees, Etc

2.1.B.e Trees
Tree tops follow similar construction style as bushes. For the foliage units use 4-5 sided shapes depending on the 
shape of the textures. Model the base shape to make the overall silhouette of the tree. Trees are the hardest to 
make. 

2.1.B.f Trunk
Model how meshes are normally modeled. Follow the silhouette of the concept art, use individual judgement on 
how to construct.

2.1.B.g Fruits / Sphere like objects
Model how meshes are normally modeled. Follow the silhouette of the concept art, use individual judgement on 
how to construct.

2.1.B Modeling Leaf Clumps and Normals for Bushy plants, Bushes, hedges, Trees, Etc

Start with Base Shape (Bottom) and Leaf Card (Top). 

https://youtu.be/v_FaGCqqGvE
https://youtu.be/dXCJHmXwy_s


Generate leaf card objects based off of the base 
objects vertex location. 
In Blender: Select the object that you want to 
duplicate. In the object properties “Parent” dropdown 
select the object (e.g. circle) on whose vertices you 
want the duplicates attached. Select that object 
(circle) now, and in the duplication section select 
verts. You should immediately see copies appear on 
the verts of your circle. Both objects remain 
independently editable. You can add or move verts on
the circle and change the mesh of the duplicated 
object without losing the setup
Randomize each leaf card’s rotation and scale. This 
is our leaf clump object.

﻿Snap Objects to Mesh Tutorial﻿

Transfer Normals over from the control object to the 
leaf clump. 

﻿Video Tutorial﻿

﻿Video Tutorial 2﻿

Create and place a “control” object over the leaf 
clump. The control object’s shading is the one that 
matters (top). 

https://youtu.be/Dt0PfqOc0ls
https://youtu.be/SuQakwmCuRM
https://youtu.be/xU7VD4s4pyA


The normals should now look something like this. 

2.1.C Adding Plant Gradients/UV4

In order to get the look of the Garden Art style the shader uses Gradients and UV4. 

-Access UV set editor with asset selected.
-In Maya: Model mode > UV > UV set editor
-Create 4 uv channels using the create (+ or new) 
button.
-Name them uv0, uv2, uv3, and uv4.
-Having four channels is a must.
-Use the uv4 Channel for gradients.
-In viewfinder make sure you are viewing the plant 
from orthographic front. 
-In uv4 channel use project from view to create UVs. 
In Maya, under UV this command is Camera Based

Scale the UVs down on the X axis and place it in the 
corresponding gradient.



PART 2.2. MODELING PROPS

Props typically have two different categories. Static Plants (Plants that don’t unlock) and objects. 

Part 2.2.A Modeling Plant Props (Static Plants)

For static plants, the process is the same as Part 2.1 Plants. Add the textures to the GardenPlant Texture (same as the 
dynamic plants).

Part 2.2.B Modeling Props 

For the most common garden props here are some modeling tips:

Buildings: 
-Delete the bottom faces of buildings, or faces that will never be seen by camera. 
-Model windows

Arches: 

Create a Cylinder.



Delete the bottom.

Select the non flat part and extrude.

select the bottom edges and extrude down.



Extrude the whole mesh.

Add any details or shape from here to get the look of the arch.

Windows: 

Start with a cube. Delete all but one plane. Extrude inward to get the 
window rim size that is appropriate. 



Mirror X, Mirror Y. Confirm that borders and vertices are merged. 

Bring in the points a bit so they are the appropriate size.

Select the frame part of the window and extrude upwards.



Stairs: 

create a cube and align it to the square in a 
grid.

Delete everything but the top and side.

Take the edge and extrude down and out to 
match grid.

Take the edges and extrude down.



Scale to make them all the same height. Merge 
together.

Make cuts. 

Merge vertices.



Straighten Lines.

Delete, Extrude.



Delete faces that won’t be seen by camera.

Modeling props and things that don’t animate, use common modeling knowledge.  

﻿10 tips to improve your 3d Modeling ﻿

﻿6 Key Principles for Modeling﻿

﻿5 Modeling Tools to Make anything in Blender﻿

PART 2.3 ANIMALS 

This section needs more information from Sophia. 

Some rules around modeling animals:

https://youtu.be/otCOwJ1z4qs
https://youtu.be/OVbIOHAI3iY
https://youtu.be/kejQ8nX5YZA


-The animals have the proper topology around areas that bend. (e.g. knees, elbows, mouth) ﻿Essential Skills to Become a Pro ﻿  
 ﻿Collapsible Joint Topology﻿ ﻿Intro to 3D Art Pixar Style Topology﻿

- The eyes of the characters are a nice shape for every side of view.

In the front view the eyes feel “squished” > Try to avoid this.

The eyes should feel a little more front facing, round eyes from both the 
front and side.

-Simplify textures, especially on small animals. 

-Keep poly count lower, 5k or under per animal.

-When modeling an animal that is similar to an already existing animal make sure to model the new character to be similar 
enough to the existing-a-like so that the rig for that other character can be used for this one.

PART 2.4 TERRAIN

The terrain should try and stay as flat as possible to keep everything simple. If there are height differences determine whether 
the height differences should be modeled into the flat plane or added on-top as a prop.

The important part of terrain modeling is the vertex painting. Vertex paint the terrain to allow for the terrain to look like the 
concept art. 8.3.A Terrain Material Overview has more information on the Terrain shader inside the game and gives more 
insight into how to paint.

Basically, 

Colors for each layer of the terrain. Each layer is controlled by the mesh vertex color:

https://youtu.be/xo9JRPhGi68
https://youtu.be/ON3gsB5AxII
https://youtu.be/5G9ziFbJJmM


Color Ground - No vertex color
Color 1 - Red vertex Color
Color 2 - Green vertex color
Color3 - Blue vertex color
Alpha - Controls whether or not the pattern shows up

PART 2.5 SKYBOX

To model the skybox, it’s easiest to take an existing skybox asset from the project folder, but can also take a sphere and delete 
the bottom half. Invert the Normals so the textures are displaying inwards. 

-Another way to handle the 
background mountains and items 
is to model them: 

 Mountains, props, etc that are on 
the horizon or in the distance will 
be modeled like so. It used a 
gradient for variety in color. 

PART 3: TEXTURING 

﻿Top 6 Blender Nodes to make any Material﻿

PART 3.1 PLANTS

Need from Sophia

PART 3.2 PROPS

-Props should have minimal detail.
(e.g. Bricks should be suggested 
not actually all rendered, moss is 
full and no holes or noise.. Etc)

-Models should be simple

-Rocks should be geometric with 
flat surfaces

-All rocks in every garden should 
share similar visual language

-rocks should have very little 
texture to them

https://youtu.be/yffWd4kI51Q


-we want the shading to create 
the depth/detail in props and 
rocks

-even small rocks should feel 
geometric

PART 3.3 ANIMALS

Need from Sophia

PART 3.4 TERRAIN

Texturing the terrain in most cases means painting the vertex colors onto the mesh. 
Colors for each layer of the terrain. Each layer is controlled by the mesh vertex color:

Color Ground - No vertex color
Color 1 - Red vertex Color
Color 2 - Green vertex color
Color3 - Blue vertex color
Alpha - Controls whether or not the pattern shows up

If there is a part of the Terrain that isn’t using the terrain shader inside Unity, then a texture and a separate mesh needs to be 
creative. 

Stylize out the texture to match the Garden style, and include it into the Props texture atlas. 

-since everything else has simpler 
textures, grass can have a little 
more detail.

-All gardens should share the 
same texture technique. 



-Alpha patterns like Animal 
Crossing Grass, shapes can vary.

-sand: exaggerated size of sand, 
low noise level

-Gravel: implied gravel, stylized so 
that not every piece of gravel is 
drawn out (example is just a 
sketch)

-Soil: patches of darker/lighter dirt 
with some rocks that match the 
darker and lighter dirt color 
(example is just a sketch)

-Raked Rocks: very graphic 
(example is just a sketch)

-best to use FLAT grounds

PART 3.5 SKYBOX

To texture the skybox, follow the concept art, base colors off concept art.

Use a 2048x2048 canvas. 

Create each layer of the skybox 
into separated illustrations on the 
texture space.



Make sure the texture can tile 
perfectly on the horizontal axis. 

-Another way to handle the 
background mountains and items 
is to model them: 

 Mountains, props, etc that are on 
the horizon or in the distance will 
be modeled like so. It used a 
gradient for variety in color. 

 

PART 4: RIGGING 

Once the model and textures are completed, it’s time to start rigging the character. If you do not have the model and textures 
finalized you will run into major issues at this stage. Any corrections to the model or texture/uv during and past this stage will 



result in needing to re-paint weights. 

PART 4.1 RIGGING FROM SCRATCH

Part 4.1.A Prepping scene

Open Maya or equivalent 
software. Set the scene working 
units to meters.  

Import the animal model 
into the scene.

Have the character facing 
camera on z-axis. Check 
placement to be in center 
and pivot point base center. 
Freeze any 
transformations, Delete 
history on scene, and check 
to make sure UVs and 
model are in tact before 
beginning any work. Name 
the mesh. Assign proper 
materials. (this should be 
done in the final stages of 
modeling. Check, if this 
already exists then skip the 
material assigning step.)  

Materials: 
Assign and name materials with the following:

Body > Body



Eyes > Eyes

Mouth > Mouth

-If the mesh doesn't have mouth atlas then that's ok, just don’t assign mouth.

Part 4.1.B Adding Bone/Joints

Now that the mesh and scene are ready to be worked on, the next step is to start placing bones/joints (they are the same thing
fyi. People refer to these with both of those names)

Got to panels in the viewport and change it 
over to orthographic side view. 



Change scene to Rigging 
mode. Use this button to 
create a joint. Can also go 
to skeleton > create joint.    
 

Start by adding a bone to the “root” of the animal. In this case it’s the hips. The rig for a quadruped should look something like 
below. It will be different depending on the animal. The best way to get an understanding of where to place the bones would 
be to look at the skeleton of the animal and think about how the animator will be animating the character. For games like 
Garden there are also bone limits (16 or fewer is optimal but for quadrupeds that can be difficult, lower the better) so being 
aware of limited amount of bones is important. 

Once the joints placed on the side orthographic view, its onto adding and adjusting bones based on other views. Currently 
there are only 2 legs with bones, and the animal has 4 legs.

in perspective mode the joints may look something 
like this. Obviously this isn’t correct placement, the 
ear and legs particularly are wrong. Lets move them 
into place.



In order to get the other legs and 
ear, duplicating the respective 
needed bone at the top of the 
chain. 

CNTRL + D and then move into 
place.

DO NOT ROTATE the bones/joints. Only translate. General rule of thumb with rigging is to not rotate the joints at all as they 
mess up the way the joints move. It’s best to have fully zeroed out bones, but translated information on bones can not be 
frozen. This is ok, just make sure there are no rotations on the bones.

Select all joints. Go to Modify > Delete all Transforms. Then go to Edit >Delete by type > Delete History. 

Name all of the joints. Here is an example of how to name them. 



Part 4.1.C Adding IKs

to create IK hit this button or go to Skeleton> Create 
IK 

Go to the tool settings of the IK.

﻿what is Ik? ﻿

Start with Rotate Plane Solver.

Rotate Plane Solver is used for the upper leg part. 
This allows for pole vectors to be attached for knee 
control. 

Using Rotate Plane Solver, Select top of leg joint and 
the ankle joint. 

https://youtu.be/S-2v_CKmVE8


Using Single Plane Solver, select ankle and then the 
toe joint.

Repeat this for each leg of the character. 

Name your Ik controls so it’s easier to manage and keep track. 
Example : LeftLeg_RP_IK, LeftLeg_SP_IK

Nest both the RP and SP IK for each leg into its corresponding curve. 
Middle button > hold down > drag.

NOTE: if you delete your IK make sure to freeze transformations on the joints that were influenced. They will hold information 
from the IK  (rotations). 

Part 4.1.D Adding Curves

To create a curve select from the 
curves/surfaces tab. Or go to 



create > Nurbs Primitives> circle.

The controls for the character will 
be curves. These can be as 
simple as circles (which is what 
garden has been using) or as 
complex as the artist wants them 
to be. 

Plug-ins and other tools can make 
this process more complex and 
quick.

For this guide circles will be used. 

Select Circle from the 
curves/surfaces tab.

Start by making the master control.
This control will allow for the animator to move the 
entire character around the scene. 

Create controls for the feet.

Create controls and place them on the shoulders and 
thighs.



Create and place controllers for the elbows and 
knees.

Create and place controls for the hips, belly and 
chest.

Create and place the controls for the head, ears and 
mouth/nose.



Create controls for the tail.

Once all the curves/controllers are placed, select all 
the controls and freeze transformation and delete 
history on those selected curves.

Name the Curves. Here is an example.



Part 4.1.E Adding Constraints

Nest all of the controls so they are influencing the right things. Example 
included here.

After everything is created it’s time to start putting 
things together.



Select the control and then the corresponding 
control. 
go to Constrain > Parent
to repeat a command hit - G (saves time when 
parenting everything together)

Do this for every joint that has a control. 

DO NOT do this for the hands/feet or 
knees/elbows. 

After constraining everything in the outliner there should be visual 
representation of the constraints created. 

Create Pole Vectors for each leg. Select the Control and the corresponding Rotate Plane Solver. Must use the Rotate Plane 
solver otherwise it won’t work. Do this for all four legs.

Everything is set up. Test the rig by moving it around. 
Make sure everything is working as expected before 



attaching skin and painting weights.

Part 4.1.E Rigging Tips

Tutorials that might help:
﻿Rigging Basics ﻿
﻿How to rig a ball﻿
﻿IK basics ﻿
﻿Quadraped Rigging ﻿
﻿Reverse Dog Leg﻿
﻿Rigging Tips﻿

-Always check assets, check for rotations, transformations, history before making the next step.
-Name things, it makes life so much easier.
-Rig only for what you need.
-Test before moving to the next step.
-Don’t be afraid to break rules, but also follow the rules when possible.

Part 4.1.F Painting Weights

Now that everything is set up it’s time to attach the mesh to the rig and paint the weights.

https://youtu.be/1wvdQy2Fdhw
https://youtu.be/qcXZ6qCKV70
https://youtu.be/9MSjYAGuG-0
https://youtu.be/g-uXLNz7-70
https://youtu.be/BPgIOgqS0Hg
https://youtu.be/Oo9nW0xFtEE


Select all joints, select the mesh to influence and go to Skin > Bind Skin

Select the mesh and then go to 
Skin > Paint Skin Weights

When selecting the joint inside the 
paint weights tool the mesh will go 
black and white. Black means no 
influence of the mesh from that 
joint, and white means absolute 
influence. 

Black = 0 influence
White = 1 influence

Grey is a value between 0-1. The 
more white, the closer to 1.

Use Mode : Paint

Paint Operation: Replace



Never use add or scale in paint operations. 

Normalize Weights : Interactive

Opacity and Value can be changed. 

Example of painting weights, hold 
down Shift and paint to smooth.

Left mouse button to paint.

Joints at the end of the chain 
typically do not have influence on 
them. There should be an 
influence of 0 on these joints. 

Inside the Paint Skin Weights tool 
there is a button labeled “Flood”

The end result should look 
something like this. 



Part 4.1.G Testing Rig

After the painted weights are applied and refined, the 
rig needs to be tested. The best way to do this is to 
move the rig around. Bend, rotate, translate each 
control to see if its deforming in the way the animator 
wants. 

Most of the time the painted weights will need to be 
adjusted. This process is back and forth. Average is 
three times back and forth to get it in a good state.

PART 4.2 ATTACHING NEW MODEL TO EXISTING RIG 

How to attach new models to existing animal rigs 
inside of garden. Whether this be an update to the 
specific model or re-using a rig for a new animal.

Part 4.2.A : Prep Scene/File for attaching Model to Existing Rig

1.

2.

3.

4.

Select the appropriate existing rig to attach new model or differing model to. Open that file. In this example the new 
bunny is attached to the bunny rig file. 

Save as a new file, name appropriately. 

Take screenshots of painted weights. Go to the Rigging mode, then at the top go to Skin > Paint Skin weights. (This is 
optional, is helpful if you need a guide)

Put scene/workspace into Rigging Mode.



5.

6.

7.

a.

b.

c.

8.

Make sure the scene is ready to be worked in. 

Make sure preference settings for the scene is set in meters and that the ground grid looks bigger than the model

Set up any preferenced tools to have easily accessible. Put tool settings as an anchored tab somewhere 
accessible. Example: on the right side next to channel, attribute and outliner. 

Test file that the animation is working and that the rig looks ok. Do this by scrubbing the animation slider on the 
bottom of the screen. (look for the little vertical lines going along horizontally with numbers, it kind of looks like a 
ruler).  To scrub you just select that area and then move with either <, > or just click and hold and drag on that 
animation slider. 



a.

b.

9.

10.

Make sure the final frame is keyed and then create a new key after that. 

Select all of the curves on the rig. The curves are the circles around the character that are moved to animate. For 
a quick selection turn off all selection masks except the curve feature. To do this find the mask selection buttons at
the top of the screen.  To create a key select the preferred frame on in the slider, and then hit S. This process is 
the same to ensure everything is keyed on that last frame. This is done incase there is a need to move around 
the rig or need to zero it out to paint weights.

Name old mesh with OLD at the end inside the scene.

Ok once the file has been prepped, it’s time to import the new model.

Part 4.2.B :  Import New model for Existing rig 

drag in new model into scene

Scale new model to fit the size of the old model. 
 
Freeze transformations on new model and delete history.



1.

a.

b.

2.

a.

i.

ii.

iii.

b.

c.

Unbind skin of old model from the rig. 

Skin > Unbind Skin

 Hide old mesh with Shift + H ;  or go to outliner to hide

Prep new model to attach to rig

Make sure the Entire Model has the right materials assigned per UVS for face-plates.

Select whole model > right click on model > Assign New Material or Assign Existing (Body)

Select UV for Eyes (right click on model go to UV) > Assign New Material or Assign Existing (Eyes)

Select UV for Mouth (right click on model go to UV) > Assign New Material or Assign Existing (Mouth)

Modify > Freeze Transforms

Edit > Delete by > Delete non-deformer history

Part 4.2.C :  Attaching Model to Existing Rig

Attach new model to rig.

1.

2.

3.

to attach model,  first select all joints and then select the model. To do this easily, go to the outliner, and go to object and 
turn everything off except joints. Now all that will show up in the outliner is the joints. Shift select the top of the chain and 
it will collapse fully. Select every joint and then select the mesh. 

go to Skin > Bind Skin. (at the top of the screen if in the rigging mode) or hit/hold space and find Skin, and hover over to 
find Bind Skin. 

Now the joints should turn Green. To test that the Mesh is attached, scrub the animation timeline, but remember what 
frame the character was at when it was bound (should be the last key on the slider).

Part 4.2.D :  Painting Weights on Existing Rig 



1.

2.

While scrubbing the animation slider there 
could be weirdness with the mesh. This is 
because the auto-weight tool isn't good. 

Weights are important because they indicate 
how much influence the joint will have on the 
mesh.

1.

2.

3.

a.

i.

ii.

iii.

iv.

v.

1.

2.

To paint weights go to Skin > Paint weights tool (again at the top or hit/hold space and look for skin)

A tool pop up should show up, dock that to the right of the screen, or whatever is preferable. This will help not needing 
to go look for it every time. 

Make sure the settings for the paint weights tool is set to :

Paint

Replace

Interactive

and use either soft round, to hard round

play around with opacity and value. 

0 = Black (no influence) , 1 = White (100% influence)

Select vertexes and use FLOOD tool to quickly fill influences on mesh, useful for blocking out 
influences or if there is a  particular part to be influenced by a set amount.



4.

5.

6.

a.

i.

ii.

1.

7.

8.

Double check every joint is on that hierarchy list inside the paint weights tool.

 Paint to match how the old mesh kind of looked, feel free to use screenshots of the older mesh. This part is more about 
common sense/feeling than a set of rules. 

However there are SOME rules that should be used:

If there is no curve on the joint, it’s influence is most likely 0 

Examples: End of tail, toes, tips of ears, tips of wings

to make sure the tips don’t get influenced lock those joints after flooding with influence value 0. 

To do this, just hit the little lock on the left of the name of the joint. once its “locked” it will go from grey
to yellow

Now that’s done,  scrub the animation and double check the animation is ok, and the model looks ok. 

When it’s done save the file.

Part 2.4.E :  Matching rig to Mesh

If the mesh does not line up well with the rig, there are a few things one can do. ‘’

First, re-position curves to match 
the points on which the curves lay. 
For this we will use the neck of the
goose to explain.

The rig is too short for the neck.

Here is a way to fix this without 
breaking the animation (this is a 
destructive workflow, but works 
fine for Garden needs):

Open Graph editor. To do this, go 
to the left and select the first grey 
square with grid, right click and a 
little dropdown menu should 
appear. Select Double Pains 
Stacked. 



The graph editor may not display 
at the bottom split screen, another 
perspective scene or another 
orthographic scene may appear. If 
this is the case, then....

1.

a.

2.

3.

Go to that second bottom 
split screen and go all the 
way over to Panels.

Panels > Panel > 
Graph Editor

Now the graph editor 
should appear (the colorful 
lines = curves)

In order to move the curve 
DO NOT just move the 
curve in the top viewport 
scene. 

1.

2.

3.

4.

move the curve VIA THE 
GRAPH EDITOR

SELECT THE 
TRANSLATION OR 
ROTATION YOU WANT TO 
MOVE THE CURVE ON

THEN HIGHLIGHT THE 
ENTIRE LINE AND MOVE 
IT VIA THAT WAY

hold the middle mouse 
button and drag it up and 
down (may need to hold 
shift while doing this, esp if 
picking multiple curves at 
once)

1.

2.

This is the MOST IMPORTANT thing, make sure to move the WHOLE CURVE

This will only work if there are NO IKS. 



3. So what about the things with IKs?

Part 2.4.F :  Replacing IK Handles on existing rig 

This is the most complicated part of re-attaching models. This should be mitigated during modeling (really think about the 
existing rig when modeling)

If there is no way around it, then here is how to move the curves with IK on them:

Go to the outliner, Collapse and make everything visible. 

Find the IK Handles. 

Delete all IK Handles. For 2 legged creatures there will be 4, for 4 legged 
there will be 8. 

1.

2.

3.

Remove all parents on legs 
by looking for the 
corresponding leg parent. 
Parents are the red link 
things in the outliner.

The joints may move out of 
place. This is ok, we can re-
position them. 

To reposition them, just 
select the joint you want to 
move and move it. Avoid 
rotating joints (this makes 
the pivots all weird). 

1. Move curves and joints to 
appropriate spot. 
Remember, when moving a 
curve select the whole 
curve in the graph editor for 
the translation or rotation to 
move it. In this case it’s the 



2.

3.

thighs. 

Once re-positioned, select 
ONLY the LEG joints and 
free transformations and 
delete non-transformer 
history.

should look like this. 

As you can see the thigh curves have been brought up, our joints are sitting in good spot, and everything is ready to re-apply 
IK to. 

1. To reapply IK go to the top 
selection or hold space, and
find the skeleton tab, 
click/hover over that to find 
the tool create IK Handle 

1.

2.

3.

To reapply IK go to the top 
selection or hold space, and
find the skeleton tab, 
click/hover over that to find 
the tool create IK Handle 

For the first IK use Rotate 
Plane Solvers. Double 
check that Rotate Plane 
Solver is selected in the tool 
settings for the IK tool. 

Select Top of joint, and then 
ankle joint. It should turn 
brown(or a different color 
like pink). Double check its 
there by viewing it in the 
outliner. It should not be 
nested under anything. 



1.

2.

3.

Now make another IK but 
this time it needs to be a 
single plane solver. This will 
connect from the ankle to 
the toe joint.  Double check 
its there by viewing it in the 
outliner. It should not be 
nested under anything. 

IK is set up for one leg. 
Time to attach, so its 
functioning properly

Drag both IKs (rename to 
R_LegIK, R_FootIK) 
underneath foot control in 
outliner. 

1. Test it, and notice the knee 
is bending really far in. The 
knee should just bend 
straight back, re-do this 
process again after moving 
the joints so it’s not so bent 
“IN”.

1.

2.

It’s properly working by 
slightly shifting the joint. 
This is an acceptable bend 
for the leg. Note some legs 
do have knees that bend 
the exact opposite of this 
one, so be careful about 
that and inform of how the 
old animal’s rig used to 
bend. 

If for some reason this 
doesn’t work, delete all leg 
joints, and re-build them. To 
do this select all leg joints in 
outliner, hit delete. Then go 
into orthographic side mode 
on the top screen. Then go 
to create > Joint. Start to 
build joints where they 
should be.



1.

2.

In perspective mode the 
new joints created are in 
the exact middle, which isn’t 
correct. Move them over 
and position them into 
place.  Select the chain of 
joints just created in the 
outliner, drag them 
underneath the root joint. 

After the one set of joints is 
in place, and nested under 
root joint, check for any 
rotations. Freeze rotations if
so. Then duplicate the 
chain of leg joints and 
position the second set on 
the other leg.

1.

2.

3.

Attach IKs(follow earlier 
steps).

Great! Set up the parent to 
the thigh and pole vector on 
this leg.

To set up the parent, select 
the Thigh/shoulder control, 
and then the 
Thigh/shoulder joint. Go to 
Constrain > Parent. That’s 
it. This is the only parent 
constraint PER LEG 
needed.

1.

2.

3.

For the Pole Vector select 
the Knee Curve, and then 
Leg IK (The rotate plane 
Solver IK set up first). DO 
NOT SELECT THE KNEE 
JOINT. 

Then go to Constrain > Pole
Vector. moving the curve 
will move the knee. 

And now do that on the 
other leg(s) and the legs 
should be good to go!

1. Double check that after all 



2.

this is set up, the animation 
still plays properly by 
scrubbing the animation 
slider. Do this before or 
after the skin is bound to 
the rig. Make sure to go 
back to the working frame, 
which should be at the end 
of the timeline.

Once legs are done, follow 
steps 3 and 4 ... then 
TEST IT AND DONE! Save 
file as a new version. 

PART 5: ANIMATION 

PART 5.1:  REQUIRED ANIMATIONS FOR ANIMALS:

Each character requires the following:

Idle 1 - this Idle will be the breathing default standing idle. It’s the most used.
Idle 2 - this idle acts like an action. The character is doing something or interacting with something in the space its in. Whether 
that be it eating something off the ground, scratching it’s head, etc. 
Idle 3 (optional but ideal) - Another action but one that is more interesting. This will be the most rare animation of the three 
idles. 
Move - This animation is the walk cycle of the animal. It allows for the animal to move around the garden.
Tap 1 - Animation that plays when the user taps on the animal. (tap animations are also used when the character is happy 
after the user completing a task.)
Tap 2 (optional but ideal) - Animation that plays when the user taps on the animal.

PART 5.2 : PREPPING FOR ANIMATION

Animation is only used in garden for the animals and insects. In order to start animating, open the file that needs animation.

Confirm that all parts of the scene are correct before animating. Check materials assigned, check naming, check rig to make 
sure it works.

However the curves are isolated is up to the artist. Either works. For 
Garden the object selection masking was used so only the curves could 
be selected in the scene. 

Turn off everything in the object 
selection mask except the curves. 

Can also create a layer and place 
the curves on a layer inside the 
display section of the channel 
box. 

use the icon with the plane and 
plus to create new layer. Right 
click on layer to add selected 
objects and rename.



Other Optional things can be done in this stage :
-Setting up animation layers
-Setting up references for animation
-deciding rough amount of frames per animation

PART 5.3 ANIMATING THE CHARACTERS

After reference is found, it is time to start animating. 

Animation is a complicated skill that takes a lot of time to master and there isn’t any one guide that will create immediate 
success. Animation should be done by someone who has studied or practiced animation for a while. It’s similar to drawing 
where, anyone can draw, but it takes time and practice to become good. 

The basics can be found here:
﻿12 principles of Animation﻿
 ﻿Become a PRO at Animation in Blend﻿﻿er﻿
﻿Animation for Beginners Blender﻿
﻿Intro to Maya : Animation Basics﻿

More advanced Tips:
﻿The Secret Animation workflow﻿
﻿The 7 Workflows of Professional Animators﻿
﻿Animate a Dog Walk Cycle ($$)﻿
﻿Cat Walk Cycle Tutorial ﻿

Part 5.3.A Reference Footage for Animating Characters

If possible, use individually created reference. If that reference isn’t available stick to stock footage. Last resort use live action 
YouTube or other source. Never Plagiarize another animator/artists work. 

For general animation tips refer to the office Animator ’s Survival Handbook.

﻿Take Your Animation to the Next Level and Create Great Reference Guide﻿

Part 5.3.B Animating Characters

Determine which animation is 
being worked on. Decide on an 
approximate amount of frames. 
Typically start with Idle 1 
animation.

Select all Curves (there are tools 
and scripts to do this but just drag 
click for simplicity reasons). 

Set a key at the start and finish. 

https://youtu.be/uDqjIdI4bF4
https://youtu.be/_C2ClFO3FAY
https://youtu.be/_C2ClFO3FAY
https://youtu.be/CBJp82tlR3M
https://youtu.be/BbeiG1YmmDc
https://youtu.be/7dAzk2oeQoA
https://youtu.be/GMTet6nd_iM
https://lms.sophoria.academy/course/animate-a-dog-walk-cycle
https://youtu.be/-G-ZDo1UXhU
https://youtu.be/BI-CEQZ6jtE


These should both be the default 
pose that is selected for Idle 1 
animation.

Pose character and set the 
corresponding frame for that 
animation. 

Keep doing that until the 
animation is complete. Clean up 
animation with graph editor. 

All of the animations per character 
should be inside one file. (this is 
garden tails specific and not the 
universal way to handle 
animations.)

Go to file > Game Exporter

Set up the frames in the animation
clips tab. 

Name each animation with a @ 
before the name of the animation

If there is more than one of that 
type of animation add a 1, 2, etc

Idle 1 should always be the idle 



that is the least interesting and is 
just the character standing and 
breathing.

Once the animations are done, it is time to export the character. Use the Game Exporter and follow Part 6.

PART 6: EXPORT FOR UNITY

6.1. EXPORT PLANTS AND PROPS

6.1.A: Delete History

 Make sure that there’s no history 
that interferes with export. For 
animated files make sure to select 
Non-Deformer History instead of 
History.

6.1.B: Freeze Transformations

The attributes panel should have 
all 0s for translate and rotate and 
1s for scale. Do NOT freeze 
transformations on animated 
files. 

6.1.C: Export (NOT on animated files)

Go to file and export selection. For animated Files 
skip step 6.1.C-6.1.E.



6.1.D: Geometry Options

Turn on smoothing groups, split 
per-vertex Normals, tangents and 
binormals, smooth mesh, and 
triangulate. 

6.1.E Units

6.1.F Naming Plants/Props: Export

Plants should be named as following : 
If the plant is an unlockable: Plant#Dynamic_PlantName 
If plant is NOT unlockable and always in scene: Plant#Static_PlantName

Props should be named as following: 
Prop_Propname

6.2 EXPORT ANIMALS / ANIMATED ASSETS

Exporting Animals requires two exports. One is for the model with the bones. The second is 
the bones and animations. 

6.2.A Export Animals Model/Bones 

Turn off 
automatic and 
set the file 
units to 
centimeters. 



First export the model/bones. 

To export animals go to File > Game Exporter. 

Select the 
bones and 
then the mesh.

6.2.B Naming the Character Model 

For Gardens Before Zen Garden... Name the character as the following: 
Land > landAnimal_AnimalName
Flying > flyingAnimal_AnimalName
Butterfly> flyingAnimal_AnimalName

For Gardens Past Zen Garden ... Name the character as following:
Land > Animal#Land_AnimalName
Flying > Animal#Flying_AnimalName
Butterfly> Animal#Butterfly_AnimalName

After exporting the Model it’s time to export the Animations.

The game 
exporter 
window will 
appear. 

Smoothing 
Groups, 
Smooth Mesh, 
Skinning, 
Triangulate, 
Tangets and 
Binormals, 
blendshapes 
and Input 
connections 
should be 
selected in 
Model tab. 

The model tab 
will be for the 
character 
model.



6.2.C Exporting Animations

The first thing to do is only select 
the joints of the character.

To export the animation part of the character, select the “Animation Clips” tab inside the Game Exporter. 

6.2.D Naming the Character Animations 

For Gardens Before Zen Garden... Name the character 
animation as the following: 

Land > landAnimal_AnimalName
Flying > flyingAnimal_AnimalName
Butterfly> flyingAnimal_AnimalName

For gardens Past Zen Garden ... Name the character 
animation as following:

Land > Animal#Land_AnimalName
Flying > Animal#Flying_AnimalName
Butterfly> Animal#Butterfly_AnimalName

Make sure to select Export 
Selection.

Label each animation clip with @ 
and then the animation name. 
Add start and end frame.

For settings, select save multiple 
clip files, and have Bake 
animation/ Input Connection 
selected. 

File type should be FBX.

 



6.2.E Animal Exporting Results 

After exporting everything it is time to start importing into unity. 

There will be one FBX that is just 
the model and the joints. 

There will be multiple FBX of just 
the joints with animations, those 
are the animation clips. 

PART 7: IMPORT TO UNITY

7.1 UNDERSTANDING THE IMPORTER TOOL

Garden has an importer tool that helps the artist by setting everything up. It creates prefabs, configs, etc. This is beneficial but 
also has it’s flaws. It’s important to understand this tool so if the import doesn’t work the way intended or if something isn’t 
importing the user has a better time understanding. 

Garden Asset Pipeline < Take a look into this document to learn more about the importer. 

The importer tool only works for the gardens past Zen garden. This is because the other gardens are on the list of Ignored 
Folders. To turn the importer off, add the garden folder into this list. To make the importer work on that garden, remove the 
garden from the ignored folders list. Find the importer tool inside GardenImportPipeline > Editor > Garden Import Pipeline 
Config. 

https://dots.quip.com/KlwnAKYJoZdv


7.1.A Pros and Cons of Importer Tool

Pros of the Importer: 
-Drag and drop, Easy access to auto setting things up

Cons of Importer:
-Uses a naming structure that doesn’t match the naming capabilities of Maya (blender does allow the unusual 
characters)
-Very rigid, one wrong spelling or set up means the importer tool won’t work properly
-Hard to change 
-Must turn it off to import assets that don’t have a structure set up in the importer or assets that need to be named 
differently.
-Creates a million folders and nests things in hard to access way.
-Folders created are capitalized (Animal instead of animals, Plant instead of plants, flying instead of Flying) which 
causes issues with the configs. 
-Only works on assets past Zen garden. 

7.2 HOW TO USE THE IMPORTER TOOL

Using the importer tool is easy. Simply drag and drop the set of assets into the project folders inside Unity. Do not do this in file 
explorer (outside of unity) the importer won’t work. 

First, create a folder for the respective garden inside Garden Assets Folder



Drag and drop in the assets. It will auto create folders and set up a folder for each asset, as well as a config. If its the first time 
importing in the garden assets it will also create a scene folder with all the basic items for the garden.

It does create folders for everything, and in some cases random empty folders are created. If that folder is not intended it is ok 
to delete. In this case ^ the empty dynamic and static folders are fine to delete. 

7.3  IMPORTING PLANTS/ PROPS

7.3.A Automatic Importer Tool Importation

To import the plants and props, pull all of the plant assets and textures from the location of where the files are and drag them 
into the corresponding garden folder. 



The plant folders should look like this. The assets should auto populate into a Plant folder and each asset should create its 
own folder. Four prefabs, config and the fbx should all be in that folder. It may take a minute or two to load the assets into the 
scene. Dynamic (unlockable plants) and Static (always in garden) folders will be created. Props will be put inside a Prop 
folder. 

The UI prefabs may appear empty, this is ok. The material is meant to be viewing in UI. 

The prefab that will be used to place inside the garden will be the Plant_Garden prefab. 

Double check that everything imported properly and the following are all displaying.

7.3.B Manual Import and Prefab Set Up for Plants

If the importer is not properly functioning (at the time of the document it was broken in apple arcade branch), follow the steps 
below:

Import in the plant assets. Create two materials for the plants. One material will be for the plant and it displaying inside the 
gardens, and the other will be for the Ui so the plants display in the catalog. 

In the desired folder (can create a materials folder or have this live inside the garden’s plant folder) right click and chose 
Create > Material. A default Unity material will appear. 



Name the material Plant^PlantNameTexture. Assign the material with the Garden/3D/Plant shader.

Drag in the correct plant texture for that garden into the texture box. Assign the corresponding gradient texture. Turn off wind 
in the material. 

Do this again for the Ui material 
for that garden. The only extra 
step is to input 1, 3 for the Stencil 
input sections.



Now it is time to work on the Plant Prefabs.

Manually Setting Up Plant Prefabs

Find an existing garden where the plants are already set up. (in this case the Opulent Garden). 

Each plant should have a config, 
imported FBX and four prefabs 
(inside a prefab folder)

The four prefabs should be:

Plant#Dynamic_PlantName

Plant_Garden_Prefab

Plant_Ui_Thumbnail_Locked

Plant_Ui_Thumbnail_Unlocked

Duplicate the following four prefabs. Move the duplicated assets into the proper plant folder for the plant being worked on.

Understanding Plant Prefabs

Plant#Dynamic_PlantName is a 
prefab that lives inside the 
Plant_Garden_Prefab and Ui 



prefabs. It acts as the fbx file 
would. It has a mesh filter, a mesh 
renderer and a Material 
assigned. 

Hierarchy:

Plant_Garden_Prefab is a prefab 
that is meant to be placed inside 
the gardens. This prefab has a 
garden plant script and an 
animator that helps the plant 
function inside the 3d garden 
space.

Hierarchy:

Plant_Ui_Thumbnail_Locked is 
a prefab that is for the catalog. 
This is the prefab that appears 
when the item inside the catalog is
locked. 

This prefab has a masked view to 
render texture script.

Hierarchy:



Setting up : Plant#Dynamic_PlantName

First focus on the Plant#Dynamic_PlantName Prefab. 

Plant_Ui_Thumbnail_Unlocked 
is a prefab that is for the catalog. 
This prefab appears when the 
item inside the catalog is 
unlocked. 

this prefab has a masked view to 
render texture script.

Duplicate all four of the 
referenced prefabs, and move 
them into the folder that 
corresponds with the plant being 
worked on.



Rename the prefab and the 
internal object to the name that 
matches the plant being worked 
on.

Assign proper mesh to the mesh 
filter.

Assign proper plant material to the
asset.

Save.



Setting up : Plant_Garden_Prefab

Double Click on the Plant_Garden_Prefab

Remove existing prefab under the Model parent if not desired plant. Add desired Plant#Dynamic_PlantName prefab under 
Model. Rename the prefab to remove the 1 (both inside the hierarchy and in the project folder).

Setting up :  Plant_Ui_Thumbnail_Locked Prefab & Plant_Ui_Thumbnail_Unlocked



Double click on the Plant_Ui_Thumbnail_Locked Prefab. 

Remove existing prefab under the Model parent if not desired plant. Add desired Plant#Dynamic_PlantName prefab under 
Model. Rename the prefab to remove the 1 (both inside the hierarchy and in the project folder). Assign the UI material to the 
newly added prefab. 

Repeat for the Plant_Ui_Thumbnail_Unlocked Prefab.

7.3.C Using the AssetGraph to re-populate Prefabs, Configs, Materials, Clean-up, ETC

To access the Asset Graph Editor : Window > AssetGraph > Open Graph Editor

Note: If submodules are messed up this tool will not work properly. 

The Asset Graph is a powerful tool for re-populating linked necessary components. Using the tool is easy, open it up and then 
select from the drop down menu the function that is needed to run. Select that function and hit execute. This can be helpful if 
prefabs, configs, variants, materials, scenes, etc are not correct. 

Example below, configs aren’t functioning properly for the garden assets:



If configs do not auto-populate access the Asset Graph. Open the asset Graph by going to Window > AssetGraph > Open 
Graph Editor. On the upper left of the Graph editors select Auto-populate Config. Hit Execute in the upper right of the Graph 
Editor window. Check to see if there are configs inside the folder. 

The final result inside that plants folder should look something like this^. The Prefabs may be in their own folder labeled 
Prefabs. 
1 Config, 1 FBX, 4 Prefabs 

7.4  IMPORTING ANIMALS

Importing Animals is the same as importing Plants. Drag in the assets and the corresponding textures into the Garden folder. A
fbx file for the model, several fbx files for the animation clips and a texture should all be imported in.  Four prefabs will be 
created. 



Double check that all animals have imported properly.

7.5 IMPORTING TERRAIN/SKYBOXES ETC

The exact same process for terrain and skyboxes. If for some reason the asset won’t import, at this time turn off the asset 
importer tool for the garden. This can be done by following steps in 7.1 Understanding the Asset Importer Tool. 

7.6 FINAL IMPORTING TOUCH-UPS

Now that everything is imported, it’s time to start looking through the assets. Triple check everything looks ok, and all assets 
are there. All configs have populated as well as all prefabs. If there are any issues try re-importation. The importer tool may 
need to be turned off if it got turned off. There are a few small things that can be done at this stage as well. 

7.6.A Changing Texture Resolutions inside Unity

If for some reason the imported texture is greater than 1024x1024 then it is important to scale down the texture. Garden 
Plant Atlas Textures should be set to 1k (1024x 1024). Animal’s textures and face plates should be set to 512x512. 
Skyboxes are 1024x1024. 



Make sure the texture compression settings are set to high. Clamp is used in wrap mode and filter mode is bilinear. 

7.6.B Inspecting Animal Assets

At this stage the model can also be checked to make sure everything is set. Uncheck things in the model tab, like blend 
shapes that are not being used. On the model no animation should be imported (since garden uses separate animation clips). 
The rig is generic and optimized. No materials should be imported as well. 

Check to make sure all animations on each animation clip are playing properly. 



Animation compression should be on, import animation should be checked. 

Check the animation by pressing play in the inspector. The asset it corresponds with should appear in that 3d window and 
there is a play button. Watch it all the way through. If there is an issue with the animation (like the key frames aren’t right) then 
adjust the key frames in the start and end input box. 

Make sure that Loop Time is on. This is super important and most of the time is not checked on. It is one of the 
major reasons why the animation won’t play inside Unity. 

PART 8: GARDEN SET UP 

Now that everything has been imported for making the garden, it is time to start making it. 

PART 8.1 OPENING THE SCENE AND IMPORTING THE WHITE BOX

Begin by opening up the corresponding Garden Unity Scene. 



It’s going to look something like this. (we are just opening to make sure it opens)

Immediately after open the French garden scene. This is the garden I’ve been using as a “whitebox” for all other gardens. 
Reality is a “white box” prefab should be set up in the default scene that populates but that was never implemented. So this will
be the hacky way to do things. 

Drag the Static Geometry prefab into the garden folder being worked on. It will ask if a prefab or variant should be created. For
the sake of not being destructive, select the variant option.

Re-Open the garden scene needing to be worked on. 
Drag in the Static Geometry prefab that was created.



This will be the guide used to make sure that assets and gardens don’t get too big/small etc. It’s to help make every garden 
feel uniform. There can be up to 30% difference in scope of garden if needed, but assets should try to maintain the scale of 
what's in the variant prefab. (again normally in a production it would be a whitebox situation instead of this hacky way).

PART 8.2: PLACING THE PROPS, PLOTS, LARGE ASSETS 

Drag in any Terrain Objects and props. Make sure to use the prefab version of the asset. Start with plots and large defining 
assets. Also any assets that are border objects for the actual garden space. 

Keep placing all of the garden prop and terrain assets into the correct places until all are placed.

Eventually the new garden should 



look something like this. All props, 
terrain, and large assets are 
placed. 

At this time the “whitebox” variant can be removed. Make sure to nest all 
of the prop assets into the props prefab under the Garden Root.

PART 8.3: SETTING UP THE TERRAIN TEXTURE

At this stage the terrain texture may not be correct to the concept art. If there is a specific terrain FBX then that should be 
imported and placed if it hasn’t already. Then assign a material to the terrain fbx. Make sure to make a new material for each 
garden terrain. 

Terrain material can be named as: 
Terrain^GardenName 

Re-using any material will affect any garden with that material (so if the cottage material is used in opulent garden and a color 
is changed in that material then the cottage garden will be affected). 

8.3.A Terrain Material Overview

Below is an overlook on the terrain material. Understanding how the material works is important to understand how to use it.

﻿Internal Overview Video of the shader﻿

In the shader selection menu select: 

https://www.dropbox.com/s/06r7691r6dzxsjv/TerrainShaderOverview.mp4?dl=0


For simple terrain like the opulent garden select 
Terrain Two. 

For more complicated terrain like the Zen garden, 
select Terrain four.  (this gives more color options for 
the fbx)

Direct Light and Ambient Light are the same as other 
shaders.

Contrast will determine how much spread there is on 
the texture. 

Light color determines the color of the light.

Light intensity determines the intensity of the light 

Ambient Intensity determines the intensity of the 
influence of ambience.  

Terrain Colors
Colors for each layer of the terrain. Each layer is 
controlled by the mesh vertex color:

Color Ground - No vertex color
Color 1 - Red vertex Color
Color 2 - Green vertex color
Color3 - Blue vertex color
Alpha - Controls whether or not the pattern 
shows up

Pattern: 
The pattern determines what pattern will be displayed 
on the ground. 

This texture is made in a 3rd party software, 
Substance Designer. It is a procedural based 
creation. For future gardens unless a skilled tech 



artist is around to help out on this, use the existing 
pattern textures inside the project for future gardens. 

The texture can also be created in photoshop 
manually. 

﻿Future of Texturing is Procedural ﻿
﻿Texture Generator Tool (realism)﻿

Alpha Source is Input Texture Alpha.

Set texture wrap mode to Repeat. 

Max size is 512, compression of high quality 
preferred but normal quality can be used as well. 

If a garden needs a specific Pattern name that 
specific pattern:

Pattern^GardenName

Transition - The transition between each layer 

follow the settings in this screenshot. 

Normal quality can be changed to high quality.

If a garden needs a specific Transition name that 
specific Transition:

Transition^GardenName

https://youtu.be/Wx9vmYwQeBg
https://www.poliigon.com/textures/generators?utm_campaign=generators-220819&utm_source=youtube.com&utm_medium=video&utm_content=poliigon-future-texturing-procedural


8.3.B Editing the Terrain Material

To change the pattern shape, input a new procedural or manual generated pattern texture. 
Change the color of each Terrain color input to match the desired colors.
Change the transition texture if needed to get desired transition between colors. 
Use contrast to affect spread. 
This might require some back and forth with Maya or software of choice. 

PART 8.4 SETTING UP THE SKY

Part 8.4.A Setting Up Skybox Dome

There are currently two things going on inside the 
Garden Project.

1.

2.

The 3D skyboxes with a texture.

The procedural sky. 

Currently the procedural sky is broken, it is suggested 
that the artist uses the old method of the 3D 
skyboxes. The reasoning behind going a procedural 
route is to optimize the memory/size of the app and 
also to reduce the amount of textures and assets. It 
also can be more performant not needing larger 
textures. This was explored because the scope of the 
game was unknown and infinite. Unfortunately it was 



never fully implemented properly so it displays broken 
in game. 

To use a skybox, import in a skybox model. Each garden might have its 
own skybox model depending on any background assets that might be 
attached to it (e.g. mountains)

Place it into the scene, assign it to a mobile unlit shader. Apply the 
appropriate texture in the texture box. 

To name the Skybox material: 
Skybox^GardenName

Skybox FBX can be named:
Skybox_GardenName

The Skybox can live inside the atmosphere prefab in the hierarchy. 

8.4.B Setting Up Procedural Sky 

Sky Ramp - A 2D texture ramp that describes the sky conditions. There is currently a hazy texture and a clear texture.

Sky top color - Very top of the sky
Sky bottom color - Right before the sky meets the 
horizon
Horizon color - Where the sky and the ground meet
Ground color - Ground
Sun Color - It replaces the color of the sky. It is not 
additive. CloudDirect Light and Ambient Light are the 
same as other shaders.
Halo Color - Additive. Color around the sun.
Fog Height - How high the fog goes
Fog Intensity - How opaque the fog is 



Cloud Texture - Atlas for the clouds sprites
Alpha Cutoff - Threshold for discarding pixels. Should 
be around .8

Distortion 
Distortion Texture - Texture used to warp the clouds
Distortion Strength - Intensity of the distortion. Should 
be around .1
Scroll Speeds - Speed that the distortion happens. 
Should be from .02 - .06
Sun Color - Color that is added to the clouds when it 
is closer to the sun

8.4.C Setting Up Clouds

Search for Clouds in the project folder. Find a prefab that most closely matches the clouds in the garden being created. 
Duplicate, rename to Clouds_GardenName. Duplicate the material that matches that prefab. Name that material 
Clouds_GardenName. 



Drag the asset into the Garden Scene. Place it inside the Atmosphere prefab. Adjust the cloud material as needed.

PART 8.5 PLACING THE PLANTS/UNLOCKABLE ASSETS

After the biggest assets are placed the unlockable assets can be placed.

Part 8.5.A Setting up Materials for Plants/Unlockables

If the unlockables do not have a material (this should auto-populate) then one can be created manually. 

To create a material, go to the materials folder inside the respective garden

Right click in the space and go to Create > Material. 

Name it : Plant^ Garden Name 

Set the shader to Garden/3D/Plant

Input the corresponding texture and gradient. 

adjust all the material settings to match the concept art. 



Set stencil mode to 0, 0. 

Cull mode Off.

Cutoff - Toggle for clipping/discarding pixels. Should be turned on for 
plants. Should be turned off for most props.
Cull Mode - Choose to discard the front facing triangles, back facing 
triangles, or don’t discard any. Default is back for the first four gardens. 
There needs to be a pass done in a model program to make sure plants 
have both sides. Cull back for all props. Cull back for almost all animals - 
do not cull back for animals with single sided features like the peacock.

Tint - Color that is multiplied with the texture prior to light calculations.

Direct Light
Multiplicative Light
Light Intensity - How strong the direct light is. 
Light Step - The threshold for where the light and shadow meet
Light Color - Color of the light
Shadow Color - Color of the shadow

Ambient Light
Additive Light
 Sky Color - Color of the sky 
Ground Color -  Color of the ground 
Ambient Intensity - How strong the ambient light is 

Rim Light
Additive Light
Rim Color - Color of the rim. It should be a darker warm color for day 
scene. Darker cool color for night scenes. 
Rim Step- The threshold for where the rim light ends.
Assign this material inside every garden prefab for the garden. 

Do these steps again for the UI material. 



Name the Ui material Plant^GardenName_Ui

The only difference here vs the regular plant shader is the stencil 
information. In the Ui texture the stencil values should be set to 1, 3. 

Part 8.5.B Placing Plants/Unlockables Assets

After every prefab has its material set up (if it didn’t already) start placing the plant prefabs. Make sure to select the 
Plant_Garden_Prefab.

 It’s important to place all the large items first, like plots to have a better understanding of where to place individual items.

Make sure when selecting which 
prefab to place, the 
Plant_Garden_Prefab is selected. 

The Plant_Garden_Prefabs can 



live underneath the Plants Prefab 
inside the garden root. 

For the Plants prefab do not 
override anything about the Plants 
Prefab. Leave everything as a + 
item. The prefabs are shared 
amongst gardens so adding 
information into the base prefab 
will make those assets appear in 
all gardens.

Keep placing all the plants and unlockables in the appropriate spaces until all assets are placed. Control + D to duplicate can 
help speed up the process. This allows the user to make a duplicate of the asset placed without having to drag in a new 
asset. 

Make sure when placing assets to not accidently add transforms, 
rotations or scale information to the children inside the 
Plant_Garden_Prefab. 

Information on children objects creates a messy workspace. 

For organization sake the user can create groups for objects, especially 
unlockable assets as there will be many of them. In this example the 
plants are grouped based on the type. Make sure no transforms, 
rotations or scale live on the parents of these groups. Only the 
Plant_Garden_Prefab assets should have transform information. 

At this point the garden should look like this (maybe minus the shadows): 



All terrain, skyboxes, static and dynamic assets placed. 

PART 8.6 SETTING UP LIGHTING FOR GARDEN

In garden, Baked Lightmaps are used in order to create the shadows seen in the game. 

To set up lighting for the garden, First find an existing .lighting asset inside the project folder 
and duplicate it. In this example the StarterGarden.lighting asset will be duplicated. 

Name it GardenName.Lighting

Maximum Lightmap size should be set to 1024. 

Turn on compress Lightmaps and ambient occlusion. 

Hover over each setting in Unity to learn what each 
means. 



Go to Window > Rendering > Lighting. 
Start inside the Scene tab. 

Drag in the new lighting settings asset that was 
created into the lighting settings section.

The following settings are a good place to start. 

Hover over each one to learn what each do. 



Switch to the Environment Tab. 

Input the Skybox material and the sun source for the 
Garden. 

The Skybox material may need to be created, visit 
section 8.4 Setting up the Sky for more information on
how to do that. 

The following are decent settings to start with. 

Adjust the shadow color if needed, as well as Fog 
color/density. 

Hide anything in the scene that should not cast 
shadows. 

Next hit the Generate Lighting button and wait. 

Check the scene that the shadows are working. 
Adjust as needed and re-bake.



PART 8.7 SETTING UP ANIMALS FOR GARDEN

Next the animals prefabs should be properly set up. 

Access the Animal Folder for the respective garden in the Project. Find the Animal_Garden_Prefab.

With the Faceplate updates, the Animal prefabs may not have any textures on them. They may even appear to not exist.

Part 8.7.A Setting up Materials for Animals

For the body of the character, create a material and 
assign Garden/3D/Animal Shader to the material. 

Name the Material :
Land Animal > LandAnimal_AnimalName
Flying Animal > FlyingAnimal_AnimalName
Butterfly> Butterfly_AnimalName

Insert Texture into texture input section.

Cull Mode: Back (only if there is nothing dependent 
on both side of faces showing, e.g. Peacock 
feathers.)



Stencil : 0,0

For The eyes or mouth, create a material and assign 
Garden/3D/Animal shader to the material.

Name the Material :
For Land Animals:

Eyes > LandAnimal_AnimalName#Eyes
Mouth 
> LandAnimal_AnimalName#Mouth

For Flying Animals:
Eyes > FlyingAnimal_AnimalName#Eyes
Mouth 
> FlyingAnimal_AnimalName#Mouth

Make sure to turn on faceplates for this material and 
set the columns to 2, and the Rows to 4. 

Cull Mode : Back

Stencil: 0,0

Duplicate each of these material to make UI 
materials. 

The settings stay the same, besides the Stencil 
values changing to 1, 3. 

Name the Ui materials with _UI at the end of the 
original material name. 



Assign the materials to the model. If the model was set up properly before export then there should be multiple slots to assign 
the materials. If only one material can be applied then separate materials Per UV spaces were not applied before export. 

Drag the materials to the respective places. Can drag onto the model, or into the material slots. 
Make sure the material is being assigned to the actual model and not the prefab parent.

Part 8.7.B Setting Up Prefab Components:  The Basics

At the top of the prefab, a lot should be assigned.

Check to make sure that the model and Animator 



Most of the time the only thing the artist may need to 
touch here is re-linking the animation controller inside 
the Animator Tab. 

have things assigned to them. The Animator should 
have landAnimal_AnimalName (Animator) or 
flyingAnimal_AnimalName(Animator) assigned to it. If 
not click on the circle on the right part of the input box 
and select the corresponding animator controller from 
the menu. 

If no animator controller exists it’s possible the fbx 
asset does not have a generic rig created. Check 
step 7.6.B for more information on how to set that up.

B Tree = Proxy (behavior tree) refers to the proxy that 
should automatically be set to the asset. Can see this 
inside the Hierarchy of the prefab. 

Nav Mesh Agent = Proxy (Nav Mesh Agent)  > Should 
be auto set up. Used to be able to walk on the nav 
mesh that’s set up in the scene file.

Wait Time before leaving = how long will the animal 
stay on the animal landing spot before moving onto a 
new spot. 

Obstacle = Proxy (Nav Mesh Obstacle)  > related to 
the nav mesh inside the scene file. Should already be 
auto-set up.

Time Between Actions = Time between actions on the 
character.

Smooth Blending = Blends smoothly between 
animation clips.

Animation Speed Multiplier = Speeds up the 
animation speed.

Idle Action Chance = Percentage chance of if an Idle 
will play.

Proxy = Refers to the Proxy inside the prefab.

Part 8.7.C Setting Up Animation Sets

The next group are the Animation Sets. 

Input the corresponding animation clips into these 
sections. 



Next, on the prefab the following need to be added:

Example of how to input the 
animation clips.

Part 8.7.D Setting Up State Machine (Face Plates)

This is for the Face Animations to 
work.

State Machine

Variables 

Face Controller (Script)

Brain (Script)



To set up the face plate system, add FaceController.cs, Brain.cs, State Machine , and Variables component on the top level. 

To add one of these components select “Add component” and type in the name of the Component. 

First add the State Machine Component. Click Create 
component and then type in State Machine. 



< The following should result.

Underneath a Variables section appears. For now 
move onto the next step, after the next two steps the 
variable will be re-visited.

Add another component. Select Add component 
button, type in Face controller. A face Controller 
Script will be added. 

Drag in the skinned mesh renderer into the Rend 
section. It should live at the bottom of the hierarchy 
inside the prefab. 

For Face Controller Script: Check on texture mouth if 
the animal has a mouth. For example, on for rabbits 
and off for horses and birds.

Blink Max and Min are how often the animal blinks.

Next add another component. Type in Brain. 

A brain script should populate. 

Set Lonely time to an appropriate time based on the 
character's personality. Make the number really high 
so it isn't always sad. 400 is a good place to start.

The bigger the number, the longer it takes for the 
animal to get lonely in the game. (The textures will 
change to sad).



Part 8.7.E Setting Up Animation Proxy

Add the following Variables to the variables tab:

Name: FaceController
Type: Face Controller Script
Value: select the circle and then the prefab that 
appears in the pop-up Should be the prefab that is 
correlating to the character.

Name: Brain
Type: Brain Script
Value : select the circle and then the prefab that 
appears in the pop-up should be the prefab that is 
correlating to the character. 

Next just double check everything that should of auto- 
populated is there. 

Check the Proxy, Nav Mesh Agent, Nav Mesh 



Part 8.7.F Checking Model Components

Obstacle, and Behavior tree should all be applied 
already. 

If not add them with the add component button. Use 
an animal prefab that is finished to reference the 
inputs. 

Part 8.7.G Setting Up Animal Sound Controller

Model should have the following information.

Radius on the sphere collider may fluctuate 
depending on the size of the animal. Adjust as 
needed.

Animal sound controller should be added to the 
model or prefab by the Sound Designer. 

-this section may need more information from a 
sound designer-



Part 8.7.H Setting up Land Animal Prefab 
Components

Part 8.7.I Setting Up Model Components

The land animal prefab has an animator and an 
animation sound player attached.

The model itself (usually the bottom of the hierarchy) 
has the following attached:

Skin Mesh Renderer

Materials

PART 8.8 SETTING UP NAV MESH



Make sure the Garden Root is selected.

See if NavMeshSurface and 
Garden Manager Script are 
applied. 

If not add both of them by using 
the Add Component button. 

Focus on the NavMeshSurface. 

Go to the hierarchy, open up the 
Navigation Manager. 

Inside there will be NonWalkPlots, 
Dynamic (landing spots), and 
NavMesh. 



For the Non-Walk Plot section 
when selecting the objects in the 
scene boxes will appear. These 
empty boxes are indicating 
spaces that should not be walked 
on. Duplicate the asset and 
scale/place the object in any area 
that is not walkable. 

For the Dynamic section there are 
a couple things going on. The 
FlyZone and FlyZoneBirds are 
boxes that if selected can be seen 
in the scene. 

These indicate where the flying 
animals can fly. Typically it’s 
scaled to match the size of the 
interior garden space.

Make sure with editing the box 
collider, the collider itself is edited 
and not the object. 



Next are the landing spots for the 
birds and butterflies. 

these are empty game objects 
with a mover spot script attached. 
Duplicate them and place them 
where ideal. 

Next are the Animal Path Points. 
There are 5 different path point 
game objects. Move and place the
white spheres into places that the 
animal should stop and idle at. 

For any of the points below, once placing the points, make sure to reset 
height for points so they stay at the right height on the ground. 

To add more points change the points number.

OutOfGardenPoints are the 
points used to indicate where the 
animals go to outside the garden. 
Place these outside the interior of 
the garden.



MythicalAnimalSpawnPoints is 
the spawn point for the mythical 
animal which no longer exists. 
Place this inside the garden, in a 
very open spot incase mythical 
animals come back.

TutorialWeedsSpawn Is where 
the weeds tutorials spawn. Place 
these in easy to access and see 
spots for the player. 



Once everything is placed it is time to bake the NavMesh. 

LandAnimalsSpawnPoints 
These are the spawn points of 
where the animals will appear 
when unlocked in game. Place 
these in easy to see and open 
areas.

Select the GardenRoot and then go to the inspector and locate the bake button under the NavMeshSurface component. Hit 
Bake. This may take a few mins to populate. A green-ish blue object will appear like the one above.  Adjust the none walk-plots
etc and re-bake as needed.

Navmesh should not appear on top of objects (e.g. top of hedges) etc.

PART 8.9 ADDING BRAMBLE/OVERGROWTH TO THE GARDEN

Next it is time to add the overgrowth/bramble asset to the garden. In the project folder search for “StarterOvergrowth”. 
Duplicate that asset and re-name it to the correct Garden. Move that asset into the proper folder 
Assets/GardenAssets/GardenName/Scene/prefabs/

Drag the new overgrowth prefab into the scene. 



Inside the prefab there will be a section called “plantables“ and ”tappables“. The plantables are removed via unlocking and 
planting a new plant. The ”tappables“ are removed via the user tapping them. 

Move and place each of the plantables to overlap with an unlockable plant if possible. Duplicate desired ones if more are 
needed. 

Tappables are removed via the user (weeds) and should be placed in a spot that makes them easy to see and tap on.

Part 8.9.A Assigning a Target Plant to the Overgrowth asset

After the assets are placed, each asset inside the plantables overgrowth needs to have a target plant attached to it. This script 
is basically saying : When this plant is unlocked, remove this piece of overgrowth.

Select from the dropdown menu in
the Target Plant Id and assign the 
one that's closest to that piece of 
overgrowth. 

Do this for every piece of 
Plantable. 

Once everything is placed, the prefab needs to be overwritten.



When selecting overrides, a lot of changes like this 
will appear. Select “Apply All”



PART 8.10 CREATING A FLYTHROUGH INTRO MOMENT CAMERA

To create the Garden intro moment camera, search for Timeline - Template Garden Intro Dolly inside the project folder. 

Duplicate that Asset and name it 
Timeline-GardenName Intro



Search for StarterGarden_Intro movie clip in the project folder. 

Duplicate this asset and name it 
“GardenName_Intro”

Drag the Garden Timeline prefab 
into the hierarchy. The game 
scene may change as the intro 
moment camera is influencing the 
game scene. 

In the scene if Gizmos is on, a 
track that looks like a rollercoaster 
will appear. 

Inside the timeline prefab:

Flythru Dolly Camera: This is the 



camera for the flythrough moment

Flythru Dolly Path: this is the 
rollercoaster track visible in the 
scene view. It’s what the camera 
moves on during the flythrough 
moment. 

Flythru Dolly Look At: Where the 
dolly is pointing at

Timeline-BlendToMain: playable 
director for the animation

Move the spheres around to move
and bend the track into the place 
that is desired. 0 is the start of the 
track. 

To add more points to have more control use the plus 
button inside the CinemachineSmoothPath script. 

Select the top of the prefab and open the timeline to preview the intro moment. Use the white tab click, hold and scrub. Can 
also press Play. 



Inside the prefab input the Garden_Intro movie clip 
into the Playable slot. 

Make sure the director is using the intro dolly. 

Remove the prefab from the scene.

Apply any over rides 

PART 8.11  ANIMAL UNLOCK SCENE

Find the AnimalUnlockMoment prefab and duplicate 
it. Rename the duplicate 
AnimalUnlockMoment_GardenName.



The new prefab can live inside the 
_NewAnimalUnlock folder. 

Find the CottageGardenGround_Unlock and 
CottageGarden_Ground_Unlock_2 and duplicate 
them. 

Rename them to 
GardenNameGardenGround_Unlock and 
GardenNameGardenGround_Unlock_2

Place the materials in the Corresponding Material 
Garden Folder. 

Open the New duplicated prefab 
and it should look something like 
this. 

Assign the new ground materials 
to the ground.  Unlock_2 goes on 
the mound and Unlock goes on 
the plane. 

Make sure that the texture Terrain Splat is selected 
for these ground textures.

Change the color inputs accordingly. 

Do this for both ground materials. 

The grounds of the unlock scenes all stay within the 
same style, only the colors changing to match the 
new garden.



Next create a background image. To create the 
background image, enter the respective garden. Try 
to screenshot the background of the garden.

For instance something like this works. 

Take it into photoshop or photo editing software and 
blur the image. Use judgement on the amount of blur.

Bring the image back into Unity and use it as a sprite 
inside the animal Unlock Scene.

Next start dragging in the garden assets. Make sure to drag in the FBX and not the prefabs. apply the regular material that 
goes to those assets. Place assets in similar fashion to how its already set up. Use the existing assets inside the garden unlock
scene for scale and placement reference. 

Once all the assets are placed, 
remove the old assets (other 
garden) and save the scene. 

Make sure all 3d/2d assets in this 



To test how it will look in game, go to the Garden scene. 

scene are set to 
AnimalUnlockScene Layer. 

Drag in the unlock moment prefab, open the timeline. 

Inside the game scene scrub along the timeline and 
the animal unlock scene should play. 

Can also press play to watch.

Make sure the settings on the prefab look like this. The moment director 
should have the corresponding garden in it. There should be 5 signal 
receivers at the bottom. 



Yay! The Animal Unlock scene is done. 

PART 8.12 GARDEN VSFX

Garden VSFX are typically done by Shirley, but in this case another person might need to make vsfx. Typically vsfx live inside 
the FX prefab of the garden root. Make sure to make a prefab per garden VSFX. Name it GardenNameVFX. 

Inside the hierarchy it should look 
something like this. 



Each garden is going to have different VSFX. Feel free to re-use vsfx from other gardens if they match the garden. For 
instance if there is a another desert garden and the dust particles wanted to be re-used they can. Make sure to duplicate 
those assets and name them GardenNameAssetName. 

PART 8.13 GARDEN CONFIGS

Currently the Garden will not play inside the game. This is because the garden has not been inputted into configs and other 
things. 

The primary things to focus on:

Garden Config:

Each Garden has it’s own Config. GardenName_WorldConfig. Search GardenName and 
look for this symbol.

Inside the Garden Config there are a few places to be 
aware of. 

Make sure the Garden Scene is the corresponding 
garden scene. 

Make sure the Display Name is correct. 

Add in the world skipper image into the book sprite 
section. The image will need to be a sprite. 

Make sure the Garden Intro Prefab has the Timeline-
GardenNameIntroDolly prefab inputted. This will need 
to be added in.

The Animal Unlock moment will need to be added to 
the config. Find the animal unlock moment controller 
prefab slot and input the 
AnimalUnlockMoment_GardenName Prefab to the 
open slot. 



In the next section there is the Beauty Bar Config. At 
least 1 tier needs to be added for the garden to work. 
Add one animal, a reward and one plant to this 
section to get the garden working. 

A game designer will fill in the rest/complete it.

The rest of the config will be worked on by an game designer so at this point the artist/dev is done.

World Config: 

To make the garden added to the game, add it to the 
WorldsConfig. Hit the plus button to add. Fill in the 
input box.

Now that both configs have the proper stuff slotted in, the garden is in a place where it should run. Follow Part 8.15 to test. 

PART 8.14 FINAL CLEAN-UP OF GARDEN

Before starting to add some of the features to the 
garden, it’s time to start organizing the garden so it’s 
neat and tidy. Move all the assets under the 
corresponding prefabs. 
FX = Visual Effects (e.g. God Rays, Water fountain 
particles)
CameraManager = no need to touch this
Atmosphere = Skybox, clouds



Plants = All plants
Props = All Props (Non-unlockables)
Terrain = the terrain of the garden (ground)
NavigationManager= the Navigation tools like spawn 
points.

PART 8.15 TESTING THE GARDEN

Try to play the game. Search for 
Init and look for the Init Scene. 
Double click to enter that scene. 

Should look something like this.

Go to Tools > Debug > Delete 
Player Prefs. Delete Player Prefs. 

Hit the Play button at the top 
center of the screen.

The screen should look like this when in play mode. 
Hit the Continue or Begin Game button.

Double click at the top of the screen, Find the Set 
Garden Progress section and change the number to 
the number garden it is. 



The game should then skip to the correct Garden. Once in the Garden begin testing. Either play the game and unlock 
currency the normal way to play the game (this is SOOO slow, not recommended.) Or add meta currency to the game.

To add meta currency double click at the top of the screen and input a 
very large number into the meta currency slot. 

Then go through the game by unlocking every plant. Do this at least once
to make sure each plant/animal is working properly. 



Another way to unlock the garden is to go to Garden > Unlock Garden 
Percentage in that same hidden HUD. Drag the slider all the way to 100 
percent. It’s a little sticky so just note that it will stick, or it could crash the 
game. This is only recommended after you’ve done an unlock pass like 
above. 

Things to Test: 

Make sure the Game Plays

Make sure the Garden Appears

Make sure the Garden intro Movement Runs

Make sure things can be unlocked and placed properly. 

Make sure the camera during unlock moments works.

Make sure the animal unlock moment is playing, the animals are animating at this moment.

Make sure user can move around the garden, zoom in and out

Make sure the animals look ok in follow cam mode

make sure the Nav mesh is working and the animals are animating/moving properly

Make sure the skybox and clouds work. 

Make sure the shadows are working properly



Make a QA Doc:

To make a QA Doc, Go here QA for Gardens and duplicate the document

Fill in the info.

PART 10: GARDEN COMPLETE 

Congrats! the Garden is complete. Now it’s time to set up a PR.

First, go to source tree and make sure no changes are left to push. 

Check File Status under the Workspace. Stage and push any changes to the remote branch.

Once everything is pushed go to GitHub. 

https://dots.quip.com/9Ma2AS4ibPWQ


Go to the gardenvariety-proto repository. 

Go to the Pull Requests Tab and then select New Pull Request.



Make sure the base will be features/apple-arcade or wherever it’s being merged. Compare should be the branch needing to 
be merged. 

Hit Create Pull Request. Follow the inputs. Hit Create Pull Request.

Announce to the team the branch is ready to be Merged. Have someone review the PR and then when approval is given, 
merge the PR in.

PART 11: Trouble Shooting / Common Problems

This section is for de-bugging when running into errors while working on Garden. Add to this section as more common issues 
are found. 

﻿https://github.com/playdots/gardenvariety-proto/wiki/Garden-Creation-Debugging﻿
﻿https://github.com/playdots/gardenvariety-proto/wiki﻿

PART 11.1 PROBLEM: CONFIGS WERE NOT POPULATING.

Solution:

-Checked naming structure of folders
- renamed folders where animals are >
-animals folder needs to be lower case
-E.g> originally was Animals, need to be animals
-flying folder needs to upper case
-E.g> originally was flying needs to be Flying
-After parent folders are named properly open asset graph.
-to access> Window > Asset Graph > Open Graph Editor
-Drop down on lower left > Look for Generate Garden Config
-Select Generate Garden Config
-Select Assets that need Configs
-Hit Execute
-Exit Unity
-Sourcetree will populate correct files
-Re-Open Unity and check

PART 11.2 PROBLEM: GARDEN FREEZES WHEN TESTING NEW GARDEN

Solution:

https://github.com/playdots/gardenvariety-proto/wiki/Garden-Creation-Debugging
https://github.com/playdots/gardenvariety-proto/wiki


-Check SucculentGardenConfig
-Make sure the appropriate slots have their items hooked up
-Make sure animals are requesting stuff

-Check WorldConfig 
-Make sure the garden you are wanting to look at is in this list.

PART 11.3 PROBLEM: COMPILER ERRORS !!!

Solution (follow options in following order, stop when the option fixes your issue) :

Option 1: Check Build Settings to make sure its platform is IOS
-File > Build Settings
-Platform > iOS (double click to switch platforms)

Option 2: Close Unity, Remove all changes on file status in file manager (sourcetree/git)(make sure you are aware if 
you are going to lose any of your work you want to keep before doing this), Re-Open Unity

Option 3: Close Unity
-Delete Library folder
-Documents > Dots> GD > Library 
-Open Unity, let it re-import everything

Option 4: Try any or all of the above and restart your computer after each option. 

PART 11.4 PROBLEM: DOTS UTILITY ISSUES/SUB MODULES

NOTE: This can also cause Compiler errors, so if none of the above worked for compiler errors check this

To identify if you are running into a dots utility issue, go to your console and check for any errors, clear errors if you can to see 
which stick around. If any mention Dots Utility then you may have a dots utility issue.

Identify exactly which Utility issue it is. 

Missing Utilities: 

If you are missing utilities go to source tree (or equivalent) and double click on dots utilities section in submodules. 

Find the submodule/utility commit that you need and just select it. (Last one was committed by Raad in 2021.)

Go back to unity, and re-open.

DotNet Folder: 
Another problem could be the DotNet folder being in the project. This folder should not exist. Find this folder in the 
Submodules folder and remove it. Restart Source Tree and Unity.

PART 11. 5 PROBLEM: ANIMALS NOT APPEARING IN GARDENS AND/OR CATALOG

Solution:

-Check the layer set on the animal prefab
-Animal prefab layer should be set to “Garden”

-Check even the children in the hierarchy, sometimes those get set to “default“


